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Apple News!
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Apple News
•There’s speculation that Apple may rename OS X to MacOS.  This 

would be consistent with iOS, WatchOS, and tvOS.

•Apple is shutting down iTunes allowance for kids.  (Most people’s 
response:  “What is iTunes allowance?”)

•Apple reported that the average iPhone user unlocks their device 
80 times per day,  & 89% use Touch ID
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Apple News
•Apple announced a new version of it’s 12-inch Retina MacBook. It 

has 15% to 18% faster CPU Performance, 25% faster graphics, one 
hour longer battery life, and a new Rose Gold color option.  It 
costs the same as the previous model.

• Apple also increased the memory on it’s MacBook Air to 8GB

•You might want to hold off on any Apple purchases until after the 
June WWDC conference.

•Apple has patented an ultra-compact folding telephoto lens for 
mobile devices.   We might see this on future iPhones.
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Your Questions
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Question

•How do you organize photos within the Photos app on 
the Mac?
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Organization in Photos
•Photos automatically organizes your photos and videos by time and 

location using the Moments, Collections, and Years views 

• A Moment is a group of photos and videos taken around the same time 
and in the same place — a walk in Eugene, Oregon

•A Collection is a group of related moments — my entire week in 
Oregon

• The Years view groups all of your photos taken in the same year.  You can 
see your entire library at a glance.  You can then drill down into your 
photos individually to find a specific group of photos.
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Organization in Photos
•Apple also provides some pre-designed albums in the Albums 

tab:

•All Photos

• Faces

• PhotoStream

• Last Import, Favorites, Selfies, 

• Screenshots, Panoramas, Videos, etc…
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Organization in Photos
•You can also manually organize your photos into Albums that you 

create 

•Note:  Albums do not actually contain the photos, just a pointer 
to the photos.  Therefore:

• You can include the same photo in multiple albums

• If you edit a photo in one album, it’s edited in all albums

•You can delete photos in an album without deleting the actual 
photos.

• To create an album, first select the photo’s you wish to include
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How to select Photos
•Select a single photo: Click the photo or press the arrow keys to quickly 

navigate to and select the photo.

• Select a group of adjacent photos:  Click the first photo, then hold down 
the Shift key while you click the last photo. 

• Select photos that are not adjacent to each other:  Hold down the 
Command key as you click each photo.

• Select all the photos:  Press Command-A or choose Edit > Select All.

• You can also click and drag your cursor over a group of photos
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Organization in Photos
•Once you’ve selected the photos you wish to include

•Click “+” in the upper right hand corner of the toolbar and choose 
Album

• In the next screen, if it’s a new album, just type in the name you wish to 
use for the album

• If you wish to add the photos to an existing album use the pull down 
menu and select the existing album you wish to use.
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Organization in Photos
•You can also organize your albums in groups by placing them in folders.

• For example, you might have several albums from cruises you’ve taken.  
You can create a cruise folder to contain all the individual albums

• To create a folder, go to the Albums view in the toolbar.

• In the File menu, choose New Folder

• Type a name for the folder

•Drag the albums you wish to include into the folder 

• To remove an item from a folder,  Right-click the item, then choose Move 
Album Out Of [folder name]
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My Recipe Book
•My Recipe Book is a 99 cent app that you use to store and 

organize your recipes. 

•My favorite feature is the ability to import recipes directly from 
websites

• Easy import from 12 sites including:  AllRecipes, Food Network, 
Cooking Light, Taste of Home, SimplyRecipes, MyRecipes, etc..

• You can also do a Custom import from any site with assisted 
copy and paste

• You can also manually add a recipe

24



25



26



27



28



29



30



31



My Recipe Book

• Icons on each recipe

•Heart:  Marks a recipe as a favorite

•Q:  Marks a recipe to a queue to try later

•Grocery Cart:  Adds all or selected ingredients to the 
grocery list.
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My Recipe Book

•Side icons from Top to Bottom:

• View Grocery List: View or add to the grocery list

• Find Recipes Online: Finds and adds recipes from 
websites

•Add a Recipe:  Adds Recipe manually

• All My Recipes: Show a list of all recipes

•Categories: Pick recipes from categories, like main 
menu, deserts, beef, Thanksgiving, etc…
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My Recipe Book

•Ready Time: Pick recipes based on time to prepare and 
cook

• Favorite Recipes: List recipes you’ve marked as favorites

• Recipe Queue: List recipes that you marked as wanting 
to try

• Surprise me: Picks a recipe at random

•Help and Settings:  FAQs, option to edit categories, and 
backup and restore
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My Recipe Book

•Bottom icons from Left to Right:

•Online takes you to original web page

• Takes the menu full screen

• Share button: Print, email, or normal sharing options

• Timer(s) that you can edit.  Sauce, Meat, etc…
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My Recipe Book
•Bottom icons from Left to Right:

• There are conversion tools for temperature (ºC/ºF), weights and 
measures, and metric to U.S.

• A servings multiplier to automatically increase or decrease the 
ingredient amounts

• Font adjuster to increase or decrease the font size
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My Recipe Book

•Using iCloud, you can sync your recipes and grocery lists 
between all your iOS devices

• You can create a grocery list from all or selected ingredients on 
a recipe, or just add items independently

• It’s very easy to share recipes via email, and if the other person 
has the app, they can automatically import it 

• Since both our daughters use this app, it’s great for sharing
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My Apple Experiences
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Since Last time
•Since last month:

• I bought a new bluetooth gadget to help with presentations

• I’ve been learning Numbers and converted all my remaining 
Excel spreadsheets

•To assist adding recipes manually, I paired an Apple Keyboard 
to our iPads

• I took an old iPod touch that I wasn’t using and figured out 
how to pair it to my car radio.  
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Since Last time
• I deleted most apps and loaded it with about 1000 songs

•Now, I use my iPhone to make and take calls in the car and the 
iPod Touch to listen to music, both paired at the same time

•The iPod is hooked up to a Belkin charger and starts and 
shutdown with the car and plays/pauses thru the car radio.

• I also purchased and installed an Amazon Echo.  While this is not 
an Apple device, it should be.  It’s one of the coolest gadgets I’ve 
seen in recent history.

• This all lead to using and learning Pandora again

46



Satechi Presenter
•A bluetooth device that has a laser pointer and allows you to 

move forward or backwards in Keynote or Powerpoint

•Costs $40 on Amazon and pairs with iPhone, iPad, Mac or any 
bluetooth computer/tablet

• To pair you just turn the device on and press the forward and 
backward buttons at the same time for 3 seconds

•Open your iPad and go to settings.  Turn on Bluetooth and 
Select ST-APA.  Can only pair w/one computer at a time.

•Only need to pair once.
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Pairing Bluetooth Presenter
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Apple keyboard
•Speaking of pairing, you can use an Apple Keyboard to pair with an 

iPad, iPhone, or a Mac

•You pair it once and after that anytime you turn the Keyboard on 
it pairs automatically

•When you have to do a lot of typing it is much much easier with 
the wireless keyboard than with the on-screen keyboard

•Note: the iPad Pro’s keyboard is not bluetooth and doesn’t require 
pairing.
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Pairing an Apple keyboard
 w/iPad

•Ensure bluetooth is enabled on the iPad/iOS device you wish to connect: 
Settings > Bluetooth.

•On the Apple bluetooth keyboard, press and hold the power button.   After 
about 5 seconds the keyboard power indicator (LED) will begin to flash 
indicating the keyboard is in pairing mode.

•When the desired “Apple Wireless Keyboard” device appears in the list of 
discovered bluetooth devices on your iPad,  tap/select it to connect.

• The iPad will then prompt you with a 4-digit code to enter on the keyboard.  

•On the keyboard, enter the 4-digit code and press the enter/return key. 
Your iPad should now be connected to the iPad.
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Local vs Cloud Music 
iPhone/iPad

• I have iTunes Match which puts my entire music collection of 
around 8600 songs in the cloud.   This allows me to play any 
song from any of my Apple devices as long as they are on WiFi.

•However, if I want to listen to music offline (in the car or 
walking) when I don’t have WiFi access, I have to download the 
songs to my device beforehand.

• So recently I needed to determine which songs were loaded on 
my iPhone, so I could tell which songs would be available to play 
in my car.   It wasn’t obvious how to do this.
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Local vs Cloud Music 
iPhone/iPad

•Launch the Music app on you phone

•Tap on the My Music tab.

• Select the “view type” dropdown (by default, it reads "Albums") 
from the middle of the screen.

• Switch “Show Music Available Offline” to “on” at the bottom of 
the pop-up.

• To see all music (offline and online) reverse this procedure or 
tap “Show all music”
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Amazon Echo
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Amazon Echo

•Amazon Echo is a hands-free speaker you control with your 
voice. 

• Echo connects to the Alexa Voice Service to play music, provide 
information, news, sports scores, weather, and more (think Siri).

• Echo has seven microphones and it can hear you from across 
the room—even while music is playing. 

• Echo is always listening.   When you want to use Echo, just say 
the wake word "Alexa" and your request.
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Amazon Echo
•Echo provides hands-free voice control for Amazon Music, 

Spotify, Pandora, iHeartRadio, and TuneIn. 

• Since it is also a Bluetooth speaker, you can stream any other 
music services (like iTunes) from your iPhone or Mac

• It provides local search from Yelp, movie showtimes, Google 
Calendar, Audible audiobooks, and it can read your Kindle 
books.

• It has a todo list and a shopping list
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Amazon Echo
•It works with the iPhone and iPad thru the Amazon Alexa app.

• Echo also has access to skills. These are 3rd-party apps that add 
functionality. Examples of skills include the ability to answer general 
questions, set an alarm, order a pizza from Dominoes, get an Uber, etc…

• I enabled a Fitbit skill.   “Alexa, ask Fitbit how I’m doing today”  This 
returns how many steps and active minutes I’ve done.

•When you first turn the Echo on, it actually talks you thru the set up 
process. I found it extremely easy to get working.  

• Echo also works with home automation devices such as lights, switches, 
and thermostats
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Amazon Echo Commands
• Play WHYY (any US radio station)

• Put eggs on my shopping list

• Play James Taylor on Pandora

• What time is it?

• What is the weather today?

• What will the weather be like in 
Chicago Monday?

• What’s on my calendar today?

• What’s my next event?

• Add Apple Users group to my calendar 
at 9:30 April 25th

• Set a repeating alarm for Monday’s at 8

• Set timer for 20 minutes

• Close the garage door

• Turn off the living room lights

• What’s new?
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Amazon Echo Commands
• Pair Bluetooth

• Stop, Play, Pause,…

• Mute, Louder, Softer, Volume 5

• Check Traffic

• How many calories in an orange?

• Who wrote Game of Thrones?

• Wikipedia “Newark”

• Check my sports scores

• What bakeries are close by?

• Read my kindle book

• Re-order AAA Batteries

• What movies are playing?
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Amazon Echo
•This is one of the coolest devices I’ve seen in a while

• It’s like a science fiction movie where you see people interacting 
with their house or the computer on StarTrek 

• It sells for $179 from Amazon, Best Buy, Staples.  

• You can also get the Amazon Dot for $89 with smaller speakers 
but you can hook it up to other speakers thru an Aux port

• The latest option is the Amazon Tap for $129.  This is like the 
Echo, but is not “Always On”.  You have to “Tap” the device to 
enable Alexa
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Numbers
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Moving from Windows

• I used primarily Windows 7 while I was working.  Just before I 
retired, I got my first Mac and since have been bipolar

• Since my Windows machine will not upgrade to Windows 10, I 
think my Windows days are over and anticipating this, I am in 
the process of moving everything to the Mac/iPad.

• To date, this has been relatively easy, but since I was a very 
experienced Excel user, I’ve been reluctant to move to 
Numbers

•This month I decided to “bite the bullet”
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Excel vs. Numbers
•Excel is the ubiquitous spreadsheet program that is standard for almost 

every organization out there.  It’s the 500 lb gorilla of spreadsheets

•Without a doubt, it is a workhorse and can do anything you could ask 
of a spreadsheet.

•Numbers while not as sophisticated (or complicated), will do 
everything that most home users would want

•Numbers is also more design oriented and you can put multiple tables 
on one worksheet (unlike Excel).  It’s much easier to mix graphics, 
graphs, and tables for reports.
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Excel vs. Numbers

•Excel is also an expensive program (>$100), while numbers is free 
when you buy a Mac.

• If you are a CPA or statistician or if you use pivot tables, slices, or 
other database like functions, then Excel is for you

• For most other users, I’d suggest not paying for Excel (Or office) and 
at least try Numbers (or iWorks)

• By the way, MS Office files are read natively by iOS and OS X so you 
can read these files if they are sent to you, without any additional 
software.  
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Excel vs. Numbers
• iWorks will also import and export Office formatted files

• I actually prefer Keynote and Pages to Powerpoint and Word

•To learn Numbers I bought the book “iWorks - The Missing Manual” 
for around $18 in Kindle format

• I find the Missing Manual books to be excellent but they are very 
extensive and might be too much for a casual user.  There are other 
simpler books out there if you wish
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Numbers
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An Excel Spreadsheet
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Numbers has a 
blank canvas as the 
background and 
unlike excel, it can 
have multiple 
independent tables 
on a sheet.

A Numbers Spreadsheet



Numbers

• I found Numbers the most difficult to learn of the iWorks 
programs.  

• It might be because I had used Excel so much that it was second 
nature.

• I had to retrain myself in the way that Numbers worked

• I did this by reading the book and trying things out in Numbers

•At the end of the day, I think I now prefer Numbers to Excel for 
the type of spreadsheets I now use.
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Numbers
• It was very easy to import all my Excel files to Numbers.  Just move 

the files to my Mac and when I opened the files, they opened 
automatically in Numbers.

• As you import, you’ll get a notice if anything doesn’t translate 
properly.   In my case, it was mostly fonts and pivot tables.

• Pivot tables were translated to regular tables and Numbers 
substituted a similar Mac font.

• All functions in Excel come over perfectly to Numbers.   In fact while 
learning about certain Numbers functions, I even used Excel articles 
on line.   
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Numbers
•Numbers is very consistent with Keynote and Pages, so skills 

translate well between the programs

•Here is one of the spreadsheets that I imported and translated 
to Excel.  

• I had used Pivot tables for this in Excel.  I got the same result 
using the Countif() and Sumif() functions in Numbers.
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Numbers
•To create an Numbers spreadsheet, just open Numbers and 

select File>New

•You then select a template.   The templates vary from blank to 
very extensive templates for managing finances, health, 
calendars, travel planners, etc…

•These templates are a great place to start or even get ideas and 
see how they were put together.
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Numbers
•This was not intended to make you a Numbers expert, but to 

give you a flavor of what it can do and how it works

•You can also run Numbers on an iPad or iPhone although the 
interface is somewhat different

•You can also use iCloud to run Numbers thru a web browser 
even on a PC

• I will now be glad to help people with Numbers, Pages, or 
Keynote in a one-on-one session.  I’m also very willing to take 
requests for questions during the monthly meetings
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Adobe Flash
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Adobe Flash
• If you don’t need Flash, you’re be better off without it.  It’s a major 

security problem, can cause performance and battery issues 

• It is also increasingly irrelevant to the web as more developers 
switch to HTML5 and other solutions

• If you absolutely need Adobe Flash to access content on the web 
that you need, at least make sure you’ve updated to the most recent 
version.  In a recent presentation, I provide information on how to 
safely update Flash

• If you already have Flash installed on your Mac and you’ve decided 
that enough is enough, here’s how to remove it once and for all.
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Removing Adobe Flash

•Open the Utilities folder in Applications

•Double-click on Adobe Flash Player Install Manager

•Click the Uninstall button
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Syncing PDF’s in iBooks

•PDFs are incredibly useful.   

•Manuals, user guides are usually provided in PDF format

•A lot of programs allow you to export as PDF (iWork, 
Safari, etc…)

•On a Mac, anything you can print can be printed as a 
PDF document.

• PDFs can be read universally across virtually any 
technology
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Syncing PDF’s in iBooks
•The ability to sync PDF’s across devices in iBooks is a new 

feature that came with iOS 9.3.

•When you first open iBooks in iOS 9.3 or OS X 10.11.4, you’ll 
be asked if you want to use iCloud.  Say yes.

•After iBooks syncs (Mine took about 24 hours), you’ll have 
access to any PDF on all your devices.

• You can add PDF’s by using the share button in iOS or dragging 
any PDF into iBooks on OS X.

•You can also sort your PDF’s easily in iBooks
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iOS
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On a Mac, just drop and drag
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My Distribution List
•Let me know:

• If you wish to be added (Need: name and email address)

• If you wish to be removed

• If you change your email address

• If you stop getting emails for no reason.  If I get failures several 
times for an individual, I’ll remove the name from my list
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One on One Training
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• Reminder:  Free “one on one” training sessions are 
available on Mondays between 1pm and 3pm in Lab 
(Except the last Monday of the month)

• Bring your own iPhone, iPad, or Mac. (or we can use 
the iMAC in the lab) 

• Training is by appointment only.  Email me or use the 
form on the Senior Surfer Web Site.



Any Questions?
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Thank You!

*Presentation produced on an iMAC using 
Apple’s Keynote software


